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Over 5 trading days as at yesterday www.shareinvestor.com | market data at your fingertips
ten-by-st 1. mouse over Ranking > select Top Active > mouse over Column Layout > select Column Layout > select Edit Customs > select Name > select Last Done Price >
SHAREINVESTOR SIED-DY-Step Edit Customs > select Name > select Volume > select Last Done Price > Mouse select 5 Days Change > select 5 Days % Change > Mouse Over Column Layout >
WEBPR® GUIDE Over Column Layout > select Custom select Custom
2. mouse over Ranking > select Top Turnover > mouse over Column Layout > 4. mouse over Ranking > select Top Losers (Over 5 Trading Days)
Sharelnvestor WebPro (www.shareinvestor.com) ﬁAeclicsteEg\‘/teg%soﬂr%Sn Igiloeuctt>N§dnlef:: ngls?gtmLaSt Done Price > select Value > S mouse over Ran:jng g Se:ed Top :/0 Gainers (Over 5 Tradqmg Days)
Prices > Stock Prices > SGX > click Stocks tab 3. mouse over Ranking > select Top Gainers (Over 5 Trading Days) > mouse over 8, st evel Relniing > Selisei Vo 6 Losizrs (Qver & ieling L)
Singapore Top Actives Top Gainers Top Losers
(as at yesterday) (over 5 Trading days as at yesterday) (over 5 Trading days as at yesterday)
Name Last Done Volume Name Last Done 5 Days Chg Name Last Done 5 Days Chg
Seatrium 0.109 277,883.50 SPDR S&P500 USS$ 438.500 18.82 GLD SG$ 244.980 -6.62
Capital World 0.003 51,870.30 SPDR DJIA US$ 334.960 3.36 GLD US$ 180.650 -3.19
HSI 18800MBeCW231228 0.054 44,272.10 XT SingGovBond SG$ 144.880 3.28 LiNing 5xShortSG240327 3.650 -2.36
SMI Vantage” 0.062 39,937.60 XT Vietnam US$ 27.040 3.14 LiNing 5xShortUB250321 3.470 -1.99
LifeBrandz 0.002 35,001.10 Nasdaq 7xLongSG260226 4.330 1.15 Venture 5xShortSG241218 2.280 -1.38
HSI 16400MBePW240130 0.081 33,901.00 Xiaomi 5xLongSG241126 2.320 1.14 Kuaisho 5xShortSG250306 0.865 -0.92
Keppel Reit 0.805 33,719.60 Jardine C&C 29.370 0.99 HSTECH 7xShortSG251029 0.810 -0.61
HSI 20200MBeCW240228 0.065 33,210.00 Venture 12.560 0.72 Tencen3xShortUB250428US$ 2.010 -0.52
YZJ Shipbldg SGD 1.470 31,604.70 XT MSINDO US$ 15.240 0.63 JD 5xShortUB250127 2.340 -0.48
Singtel 2.400 24,847.10 Amundi EM Mkt US$ 11.690 0.58 HSTECH3xShortMA260327US$ 1.735 -0.46
Singapore Top Turnover Top % Gainers Top % Losers
(as at yesterday) (over 5 Trading days as at yesterday) (over 5 Trading days as at yesterday)
Name Last Done Value Name Last Done 5 Days % Chg Name Last Done 5 Days % Chg
DBS 33.360 93,823,661.00 GS Hidg 0.045 200.00 AAC 5xShortSG231123 0.068 -67.62
OCBC Bank 13.060 78,106,565.00 Katrina W281008 0.006 200.00 Xiaomi 5xShortUB250321 0.013 -58.06
Singtel 2.400 59,503,809.00 NauticAWT 0.009 200.00 Kuaisho 5xShortSG231220 0.119 -52.40
uoB 27.660 56,034,842.00 MSM Intl 0.057 111.11 Xiaomi 5xShortSG231220 0.010 -52.38
YZJ Shipbldg SGD 1.470 46,583,761.00 AAC 5xLongSG240327 0.057 119.23 Kuaisho 5xShortSG250306 0.865 -51.54
SIA 6.280 44,277,757.00 Bilibili 5xLongSG231220 0.002 100.00 Sevens Atelier 0.025 -50.98
Seatrium 0.109 30,293,271.00 Joyas Intl 0.002 100.00 HSI 16600MBePW231129 0.030 -50.82
JMH USD 40.320 28334.364.00 Rich Capital 0.002 100.00 DBS MB ePW231227 0.006 -50.00
CapLand Ascendas REIT 2.730 28,237,909.00 Xiaomi 5xLongUB250228 0.046 100.00 HSI 15800MBePW231129 0.015 -50.00
Keppel Reit 0.805 26,813,664.00 Xiaomi 5xLongUB250930 0.955 98.96 Sunny 5xShortSG231115 0.017 -50.00

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for
damages resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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MARKETS

Over 5 tradlng days SHAREINVESTOR Sharelnvestor WebPro (www.shareinvestor.com)
@ WEBPR® 1. Price > Stock prices
step-by-step 2. select Market: Bursa / HKEX / NYSE / NASDAQ (one bourse at a time)
<~ GUIDE 3. select Stocks Tab
4. select Ranking Top Gainers or Top Losers (Over 5 Trading Days)
5. Mouse over Column Layout > select Edit Customs > select Name > select Last Done Price > select 5 Days
Change > select 52 Weeks High > select 52 Weeks Low > Mouse Over Column Layout > select Custom
Top Gainers Top Losers
5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High e Name Last Done Change High e
F&N 27.480 1.720 27.900 20.100 PPB 14.500 -0.700 18.000 14.520
MPI 26.940 1.520 34.980 23.840 NESTLE 122.000 -0.500 140.600 120.100
ALLIANZ 16.800 0.760 16.760 13.240 HSI-HPQ 0.920 -0.390 1.320 0.765
AEONCR 11.900 0.620 13.500 10.880 HSI-HPY 0.865 -0.365 1.230 0.740
ALLIANZ-PA 17.380 0.480 17.800 13.120 SP500-H33 0.255 -0.295 0.645 0.265
Top Gainers Top Losers
5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High T Name Last Done Change High e
BOSERA ASSET MGT (INTL) CO LTD BOSERA SPDR GOLD TRUST GOLD SHARES NPV 1,411.000 -23.000 1,498.000 1,243.000
RMB MONEY MARKET ETF HKD 1,092.500 983.250 1,092.500 108.350 ,
NOAH HOLDINGS PRIVATE WEALTH AND AS 187.200 168.480 187.200 17.500 YUM CHINA HOLDINGS INC 344.000 L 514.500 ALY
MIRAE ASSET GBL INVMTS (HK)LTD GLOBAL X
XTRACKERS MSCI KOREA UCITSETF 1C 561.200 46.800 637.000 514.400 USD MONEY MARKET ETF USD 993.750 -5.850 999.600 984.050
XTRACKERS MSCI USA SWAP UCITS ETF 1C 996.000 46.000 1,035.000 841.600 YSBINC 16.640 -5.110 64.500 15.860
XTRACKERS NIFTY 50 SWAP UCITSETF 1C 1,749.500 29.500 1,827.500 1,549.500 CSOP ASSET MANAGEMENT LTD HKD MONEY 1,013.500 -4.550 1,018.300 903.100
MARKET ETF CNY
Top Gainers Top Losers
5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High e Name Last Done Change High Low
NVRINC 5,901.820 202.910 6,525.000 4,050.710 BERKSHIRE HATHAWAY INC 526,660.000 -3,680.000 566,569.970 434,925.000
AUTOZONE INC 2,652.850 106.830 2,750.000 2,277.880 TEXAS PACIFIC LAND CORPORATION 1,650.550 -147.250 2,739.000 1,266.210
GARTNER INC 401.140 63.550 401.420 292.600 INSPIRE MEDICAL SYSTEMS INC 129.950 -30.360 330.000 129.900
CHIPOTLE MEXICAN GRILL 2,084.000 48.630 2,175.010 1,344.050 AIR PRODUCTS & CHEMICALS INC 259.930 -29.690 328.560 251.630
METTLER-TOLEDO INTERNATIONAL INC 1,038.280 47.070 1,615.970 928.495 BILL HOLDINGS INC 62.190 -27.280 139.500 58.150
Top Gainers Top Losers
5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High Low Name Last Done Change High Low
BOOKING HOLDINGS INC 3,020.340 181.720 3,251.709 1,830.070 SHOCKWAVE MEDICAL INC 170.300 -44.650 315.950 172.500
MERCADOLIBRE INC 1,367.340 47.840 1,451.560 815.855 FOX FACTORY HOLDING CORP 57.250 -25.880 127.540 49.120
MONGODB INC 370.040 41.040 439.000 135.150 PAYLOCITY HOLDING CORPORATION 151.360 -20.500 235.000 139.395
BROADCOM INC 911.130 39.830 925.910 469.030 ATRION CORP 320.400 -18.090 705.740 305.050
NVIDIA CORP 465.740 30.680 502.660 137.590 KRYSTAL BIOTECH INC 102.250 -16.800 132.680 69.810

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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SE=S T S STOCK MARKET DATA
~ _® AT YOURFINGERTIPS

=t Powerful browser-based market analytics platform.
B Access from anywhere

......

©
Portfolio
Management
© » Profit & Loss Summary
8 Markets Data > Stock Alert
P Get access to data from » News & Events filtering

Bursa, NYSE, Nasdagq,
HKEX, SGX, IDX, SET & ASX

@ Fundamental Analysis @

@ » Customizable column layout

Financial Analysis ® ® © FactSheet
@ Statement > Key Stock Information ()

» Profit & Loss T h . I B k y » Ownership

» Balance Sheet © ec n-lca © FOKErS » Consensus Estimates
Chartlng ca" » Annual Report

» Cash Flow Statement » C? chart (Customisable & ® o .

» More than 20 Financial Ratios Comprehensive) o » Historical Price

» Dividend Analysis gﬂrll‘ISIC Value » Insider Trades

alculator

What’s new on WebPro (stable Release 12.1.0)

In our effort to keep our platform at the forefront of trading technology, we have added on some
new features onto our C2 Chart in WebPro

ADDITIONAL NEW FEATURES:
Anchor selector for AVWAP, PVAT, and PAV indicators
Volume profile indicator by date range
Moving Average Cross indicator
Guppy Multiple Moving Average (GMMA) indicator
GoNoGo Trend Signal indicators
SignallQ

So what are you waiting for? Head to our platform today and check out our new trading chart
features and indicators. We're confident that you'll love the improvements we've made and that
they'll help you become a more successful trader.

Click here to start your 9 days FREE trial
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Dividend Stocks (as at yesterday)

for weekly InveSt @
(&]
DEFINITION Company is paying out dividend with low or moderate leverage. o
-
CHART GUIDE  Total Shareholder Return (TSR) combines share price appreciation and distributions paid to show the total return to the shareholder expressed as a percentage. (2]
Sharelnvestor WebPro > Screener > Market Screener + Fundamental Analysis Conditions tab >select (v) Total Shareholder Returns 6. CAGR of Dividend Per Share - select (less than) type (30)
SHAREINVESTOR (FA &TA) > select SGX > add criteria + Fundamental Analysis Conditions tab / >select (vi) CAGR of Dividend Per Share % for the past select (5) financial year(s)
WEBPR®) A. Criteria - Fundamental Analysis Conditions tab >select (vii) CAGR of Dividend Per Share 7. CAGR of Dividend Per Share - select (more than) type (1)
step-by-step > click Add Criteria B. Conditions (Criteria Filters) % for the past select (5) financial year(s) »
+ Fundamental Analysis Conditions tab >select (i) 1. Dividend Yield - select (more than) type (1) % for the past select (1) financial year(s) > click Save Template > Create New Template type (Dividend
Dividend Yield 2. Dividend Payout (Historical) - select (between) type (0.5) to type (1) times for the Companies) > click Create o i
Fundamental Analysis Conditions tab >select (ii) past select (1) financial year(s) > click Save Template as > select Dividend Companies >
Dividend Payout (Historical) 3. Total Debt to Equity — select (less than) type (1) for the past select (1) financial click Save _
Fundamental Analysis Conditions tab >select (iii) year(s) > click Sgreen Now (may take a few minutes)
Total Debt To Equity 4. Total Shareholder Return — select (more than) type (5) % for the past select (3) > Sort By: Select (Dividend Yield) Select (Desc)
Fundamental Analysis Conditions tab >select (iv) financial year(s) > Mouse over stock name > Factsheet > looking for Total
Total Shareholder Returns 5. Total Shareholder Return — select (more than) type (5) % for the past select (5) Shareholder Return

financial year(s)

New Toyo Int Hidgs Ltd.
(NO8.SI)

Tolel Bhar ohoicker Sirken
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Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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STATION

©® 8 Markets Data © Dynamic Chart

» Get access to data from Bursa, NYSE, Nasdag, » Candlestick Pattern Recognition

HKEX, SGX, IDX, SET & ASX » 111 Indicators

» 39 Drawing Tools
» Performance Comparison Chart

© Intraday Data © Market Screener
» Market Depth 4 ?_2 cgteria rangirlwzgtfrorrl FA, @ Power Frame

» Trade Summary Matrix & Chart .
» Times & Sales > Real-time Data » Combining few Dynamic
Charts together with intraday

> Intraday Market Ticker . o
information in one frame

© © O, © ©,
Technical Analysis

o Fundamental Analysis o

©  Financial Analysis FactSheet ©
Statement b Key Stock Information
» Profit & Loss » Ownership
» Balance Sheet Start your 18 dayS T b Consensus Estimates
» Cash Flow Statement FREE tri a| now - i » Annual Report
» More than 20 Financial Ratios » Historical Pri
» Dividend Analysis (Valued at SGD$52 40) E {;? > In;;ercjradeze
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Fundamental Analys

Growth Stocks (as at yesterday)

DEFINITION Company revenue is growing and making good quality of earnings with positive Free Cash Flow.

for weekly InveS$t

STOCKS

CHART GUIDE Total Shareholder Return (TSR) combines share price appreciation and distributions paid to show the total return to the shareholder expressed as a percentage.

Sharelnvestor WebPro > Screener > Market Screener B. Conditions (Criteria Filters) > click Save Template as > select Growth
SHAREINVESTOR (FA & TA) > select SGX > add criteria 1. Free Cash Flow — select (more than) type (1) for the past select (1) financial year(s) Companies > click Save
WEBPR@ A. Criteria 2. Revenue Growth — select (more than) type (1) for the past select (1) financial year(s) > click Screen Now (may take a few minutes)
step-by-step 1. Fundamental Analysis Conditions tab >select (i) 3. Gross Profit (Earnings) Margin - select (more than) type (30) % for the past select (1) > Sort By: Select (Revenue Growth) Select
Free Cash Flow, (ii) Revenue Growth, (iii) Gross financial year(s) _ (Desc)
Profit (Earnings) Margin, (iv) Quality of Earnings 4. Quality of Earnings — select (more than) type (1) for the past select (1) financial year(s) > Mouse over stock name > Factsheet >
(v) Total Shareholder Returns 5. Total Shareholder Return — select (more than) type (5) % for the past select (3) financial looking for Total Shareholder Return
> click Add Criteria year(s) )
2. Fundamental Analysis Conditions tab >select 6. Total Shareholder Return — select (more than) type (5) % for the past select (5) financial
(vi) Total Shareholder Returns year(s) , ,
> click Add Criteria > click Save Template > Create New Template type (Growth Companies) > click Create

MarcoPolo Marine Ltd.
(5LY.SI)

olel Frarcholde Mrben

A TR Kl

Genting Singapore Limited
(G13.51)

Totml Srarehodter Renem

Arrssalined Rehum

Grand Banks Yachts
Limited (G50.SI)

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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COMPANY ANALYSIS AT YOUR FINGERTIPS

Click the Analysis buttons to access the Factsheets of
any company featured on the Hot Stocks (TA),

Momentum-Up (TA), Up-Trending (TA), Dividend (FA),
Growth (FA) & Value (FA) Stocks pages.

Invest,with knowledge

SHAREINVESTOR.CO Shirsimester Memborstip P
E

Your Wirsdow To Global Invesiments WERFRC - STARGIN

r
| Tyoe your ssarch quany ko stan

Home Frices Porfiollo  Fundamental Screaner Charts Communlly PO News  Everds  INVEST

Your congestion-free,
o= stog port

to ship to Conada

£ the US Midwest

SGY Market
Fundamental - Facisheet e

Factibwal | Firamcials = basider Trades  Ownerahip | Company Buybach  Events Calendar Dévidand Anslysis | Annual Reports
Stocks Cosmparisca | Consensus Eslimabes

Factihest Intraday Warke! Tickar

Salect Counter: | 5GX * | Ge Energy Res [RELST)

Geo Energy Ras GEO ERERGY RESOURCES LIMTED
range #0039

L 3000 0,400 $ 7 AT

Open
By Price

ey Viohumas (0039
Cormulative Viokans (003

Company Background

imEyme

raup is an meiahl

u satabiinhu in 008, (o Ersrgy Geoup aumanty cwns PT Bumi Enggang Khabuiatws [BEX), e Mining Business Licssss (1L} omrer ¢
s in Kutai Barsl, Easl Kslimantan, ar

it i sapaenced coal mining Grous opealing oul of Indorosis, Mssdouarisnsd in Singapcne with a Birsnch Ofics in Jalkarta, Indonesis, Gad
.

5 4570 hactien coai
ol subaicany companies Tl an responsibls o mining, as well i Baevy egupment and machineny prooanament Snd nental

7] ¥ide Sanck Prices chart

inaicer TracesT) B Hess(n|

1wy §om  Octd, 2021 Ta Ouct &, 2032

Candlestick
Chart

Total Shareholder IPO

Returns \ performance

Historical Price More
Data



https://www.shareinvestor.com/fundamental/factsheet.html?counter=RE4.SI
https://www.shareinvestor.com/fundamental/factsheet.html?counter=RE4.SI

Invest FRIDAY NOVEMBER 10,2023 10

Fundamental Analysis

Va I ue Stoc kS (as at yesterday) for weekly InveS$t

DEFINITION Share price of a company trading at a lower price as compared to its fundamentals (FA) such as financial performance and dividend, allowing it to be attractive to value investors.

STOCKS

CHART GUIDE Total Shareholder Return (TSR) combines share price appreciation and dividend distributions paid to show the total return to the shareholder expressed as a percentage.

Sharelnvestor WebPro > Screener > Market Screener (FA & TA) > select SGX B. Conditions > click Save Template > Create New Template type
SHAREINVESTOR > add criteria 1. Price Earnings Ratio — select (less than) type (15) times (Value Stock) > click Create
WEBPR@ - now > click Save Template as > select Value Companies >
step-by-ste A erterla o 2. CAGR of Net Earnings — select (more than) type (10) % click Save
p-Dy-Step >click Add Criteria » o ) , for the past type (3) financial year(s) > click Screen Now (may take a few minutes)
Fundamental Analys!s Cond!t!ons tab (i) Price Earnlngs Ratio ) 3. Net Debt To Equity — select (less than) type (1) for the > Mouse over stock name > Factsheet > looking for
Fundamental Analysis Conditions tab >select (i) CAGR of Net Earnings past select (1) financial year(s) Total Shareholder Return
Fundamental Analysis Conditions tab >select (iii) Net Debt To Equity 4. Return On Equity (ROE) - select (more than) type (10) % > Mouse over stock name > Charts > click C2 Charts tab

Fundamental Analysis Conditions tab >select (iv) Return On Equity (ROE) for the past select (1) financial year(s)

China Intl Hidgs Ltd.
(BEH.SI)

Tolal B whoichr Fielurn

Metius Tarrn Rrtam

Samudera Shipping
Line Ltd. (S56.SI)

Tolel Bhae ohoicer Sirben

Fuji Offset Plates Mfg Ltd
(508.50)

Tolel Bhae ohoicer Sirben

Bhort Term Betem

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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COMPANY SPOTLIGHT

Top Stock Market Sectors Thriving
in High Inflation and High Interest
Rate Environment

Vincent Wong, Investor-One / Mon, Nov 6, 5:00 PM

"Inflation is like toothpaste. Once it's out, you can hardly get it back in again,”
- Karl Otto Pohl

Fed Chair Jerome Powell said the central bank will leave its benchmark
interest rate unchanged last week, marking the second consecutive meeting
with no increase. T-bill yield dropped from 5% to around 4.6%, and all things
started to look brighter despite a very hawkish remark made by the fed
chairman previously, "Higher for longer".

The Federal Reserve's decision to keep the benchmark interest rate
unchanged is certainly a breather for markets. As a result, the US stock
market just had the best week of this year. However, this pause doesn't
necessarily signal a reversal of policy or an all-clear for the economy.

continued on next page...
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continued... [Top Stock Market Sectors Thriving in High Inflation and High Interest
Rate Environment]

IDEAS

Investors pondering whether inflation has peaked or if interest rates will
decline further should tread carefully. History tells us that inflation can

be stubborn, and once expectations of higher prices become entrenched,
they can be difficult to uproot. Moreover, the labor market remains tight,
and other economic indicators suggest resilience, giving the Fed leeway to
remain hawkish if inflation does not cool as anticipated.

We could still get stuck with a really bad combination of sticky inflation and
high-interest rates.

To hedge against these risks, investors should consider a selection of
stocks that can weather high-interest rates or inflationary environments.
Historically, certain sectors have shown resilience or even benefited during
such times, while certain stocks show weakness.

Read Also: U.S. Treasury Yields at 16-Year High: What It Means for
Investors

When inflation and interest rates are high, stocks usually struggle. But
looking back, certain sectors could still shine. Here are a few sectors that
might offer investors a bit of protection and variety in such times:

Between 1973-2022, when the inflation rates were over 3%, the energy
sector did well. Their stock performance beat the inflation rate by 74% and
gave an average yearly return of 12.9%.

Why? Well, these companies usually own a lot of physical stuff — think oil,
gas, coal reserves, etc. When inflation rises, the prices for the oil and gas
they sell typically rise too. So, while other sectors might have felt the pinch,
energy companies had these built-in cushions that helped them ride out the
rough patches.

Furthermore, during times of high political tension and wars (Nowadays),
the energy sector often performs strongly. This is because global
uncertainties and conflicts can disrupt commodity supplies, which often
drives up prices and benefits these companies.

continued on next page...
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So, if you want to hedge against inflation (or war), you know what to look
for.

Stock Examples:

* RH PetroGas (SGX: T13)

* Interra Resource (SGX: 5GI)

* Geo Energy Resources (SGX: RE4)

Risk:

- The number one risk for energy companies in developing countries
would be jurisdiction risk. Energy companies are highly regulated entities
and sudden shifts in regulations can have profound effects on their
operations. In addition, the legal protections afforded to investors can
vary greatly between jurisdictions.

« The sustained profitability of the traditional energy sector could spark
renewed enthusiasm, prompting companies to ramp up production. With
financial institutions increasingly open to financing these expansions
despite ESG concerns, there's a potential risk of creating an oversupply in
the market again.

S&P 500 Energy

For the last 3 years, Energy has been the top performer with a strong
44.34% annualized return.

The S&P 500 Index has shown a good performance this year, but excluding
the top companies, which unsurprisingly are all tech companies. The
performance of the remaining “S&P 493" is struggling this year so far.

This is because technology firms typically have a large cash reserve, a
significant advantage when interest rates are high. This financial buffer
allows these companies to fuel growth with less dependence on debt,
setting them apart from their peers in other industries.

continued on next page...
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Also, these companies are not only fortified with large cash reserves, but
they also enjoy a degree of monopolistic influence within their respective
markets. This positioning enables them to pass on additional costs to
consumers with relative ease, thus mitigating the impact of inflation.

Stock Example:

* Apple (NASDAQ: AAPL)

* Microsoft (NASDAQ: MSFT)
* Alphabet (NASDAQ: GOOGL)

Risk

 Overvaluation Risk: Technology stocks often trade at high multiples
due to growth expectations and certainty. In case of slower growth or
technology disruption, these valuations can contract sharply.

« Weaker consumer spending: Increased living costs or a potential
recession could curtail consumer and business spending on technology
products and services, potentially impacting the revenue streams of tech
companies.

Read Also: A Stock with Dividend Growth of 40% and Strong Revenue
Growth on SGX

When the Fed raises interest rates, it often spells greater profits for banks.
Here's why: banks make money on the difference between the interest they
charge on loans, like mortgages and car loans, and the interest they pay on
deposits, such as savings accounts.

This difference is known as the net interest margin. As interest rates go
up, banks can increase loan rates more than deposit rates, boosting their
margins and profitability. This makes banks potentially more appealing to
investors during times when interest rates are climbing.

In our opinion, It is safer to Invest in Singapore banks for now, with their
reputable stability and familiar regulatory environment, can be a safer bet
for investors than venturing into lesser-known regional banks abroad, which
may present more uncertainty in their assets.

continued on next page...
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In addition, Insurance stocks often do relatively well when interest rates go
up. Insurance companies need to invest a majority of their reserve in risk-
free assets, which have become more attractive now, due to regulation. And
historical data tells us they generally hold their ground well when rates rise.

Stock Examples:

- DBS (SGX: D05)

« OCBC (SGX: 039)

* Great Eastern (SGX: G07)

Risks:

« Inflated Claims: If claims are higher than expected due to inflation,
insurers might not have set aside enough money. Plus, in places where
competition is fierce or there's public pushback, insurers could struggle to
raise prices in line with inflation, squeezing their profits

* Credit Risk: A severe recession will increase the risk of loan defaults
which can lead to significant financial losses for the bank.

- Banks might face interest rate risk because of the mismatch in
the maturity of their assets and liabilities. When interest rates rise
unexpectedly, the value of a bank's longer-term fixed-rate assets, like
loans, may decline, while the costs of their short-term liabilities, like
deposits, may increase faster than expected. This can squeeze the net
interest margin and affect earnings.

S&P Insurance Select
Industry Index

In high inflation or during geopolitical unrest, precious metals like gold
could do quite well. But gold mining stock might be too unpredictable for
retail investors.

However, the renewable energy shift is a more certain trend and is also a
boon for mining. Electric vehicles, for example, use a significant amount of
lithium and much more copper than standard cars. New solar panels and
windmill projects require huge amounts of mining materials.

continued on next page...
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When the world leans into renewables, it's less about the consumable
energy sources and more about the materials we need. This transition
magnifies the importance of mining, particularly as we chase a greener
future as Singapore gets hotter.

Stock Examples:
* Rio Tinto PLC (NYSE: RIO)
« BHP Group (NYSE: BHP)

Risks:
- Jurisdiction risks as mentioned in the Energy sector above.
* Increase cost for extraction due to higher labor costs.

S&P Metals & Mining
Select Industry Index

26.78%

On the other hand, historically, companies in some industries often see their
costs go up with inflation. This is because they consume commodities or use
human labor that gets more expensive. And that is not good for profit and
stock price. Here are some examples of industries that are likely to be affected:

Counterintuitive, why are these traditionally “defensive stocks” a bad
sector? The sector that sells essential day-to-day items to consumers often
does not have a business moat and lacks cost transfer power.

Most importantly, these stocks often pay dividends, but only look bad when
compared to rising risk-free T-Bills that have competitive yields while their
operation and financial costs are rising.

It has a YTD performance of -8.35 %, the sector is the S&P 500's second
worst-performing sector in 2023 for a reason.

continued on next page...
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Stock Examples:

+ Japfa (SGX: UD2)

* Wilmar (SGX: F34)

* Clorox Co (NYSE: CLX)

Potential turnaround:

- Stabilizing Input Costs: A drop or stabilization in the costs of raw
materials, labour, and shipping can significantly improve profit margins,
making these companies more attractive to investors.

- Reduce Interest rate: If the Fed's rate goes down because of stabilizing
inflation, their financial cost as well as costs of mergers and acquisitions
will go down. The dividend that they offer will look attractive again when
T-bill's yields are lower.

S&P 500 Consumer
Staples

These companies often carry a good amount of debt for their big projects.
Rising interest rates mean their borrowing costs go up. They also use lots
of inflationary energy resources, whose prices are climbing.

A challenge for them is fully passing these higher costs onto customers.
In Singapore, higher power prices boosted local utilities last year, but it's
uncertain if this will last. The services they offer aren't designed for quick
profit growth.

And when you compare their dividend yields to the 10-year risk-free T-bill,
they don't stack up well. So, it might be best to tread carefully with this
sector right now.

Stock Examples:
 Keppel Corp (SGX: BN4)
 Sembcorp Industries (SGX:BHK)

continued on next page...
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Potential Turnaround:

- Stabilizing Input Costs as mentioned above.
Big Renewable energy projects could broaden their income streams if
they could control their costs.

S&P 500 Utilities

Read Also: Seatrium Unveiled: Expert Insights on Temasek's Offshore
Powerhouse

Prolonged inflation and longer-than-expected high-interest rates can spook
the market temporarily, but over the long haul, stocks are seen as a solid
defense against inflation. Remember, investing is a marathon, not a sprint!
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Curated and managed by the Investor-One team under Sharelnvestor,
this free-to-access portfolio will feature local small and mid-cap companies
within Singapore Exchange’s Mainboard and Catalist.

Join us on the journey and watch as we manage a locally vested portfolio
with a fund of $100,000.
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Tracking a Live portfolio of local small
and mid-cap companies

Updates
for October 2023

Vincent Wong, Investor-One / Tue, Nov 7, 8:00 PM
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In October, we witnessed a slight recalibration in our year-to-date (YTD)
returns, which now stand at +2.02%, including dividends. While this reflects
a marginal step back from the +2.46% achieved in September.

The market currents have indeed been challenging, and our reference index,
the FTSE ST Small Cap, continues to navigate through turbulent waters. Its
YTD performance has further slipped to -13%.

Our total return has maintained a positive territory at +1.8%. This figure,
though humble, stands as a testament to our commitment to capital
preservation. We have successfully navigated away from the more severe
repercussions of asset revaluations prompted by the rising interest rate
environment, thereby safeguarding our portfolio's value.

continued on next page...
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On the Other hand, the benChmark Tracking a Live portfolio of local small §
has seen a stark contrast, posting ang Mic-cap R

a negative -30% return in the

same timeframe. This widening
gap underscores the volatility and
challenges within this segment but
shines a light on our resilience and
prudent investment approach.

Read Also: Investor-One Portfolio: Updates for September 2023

On October 18, Geo Energy Resources completed the acquisition of 58.65%
stake in PT Golden Eagle Energy and PT Marga Bara Jaya.

From the announcement by the company, these reserves were valued at a
preferred value of US$S809 million based on the 2023 variable coal forecast
and a preferred value of USS957 million based on a constant coal price as
set out in the Independent Qualified Persons’ Report and Valuation Report
announced on 24 August 2023.

The company, Geo, has a market cap of just $315 million. So, it seems like
the deal could be a good one for investors.

A day after the completion of the acquisition, there were three insider
trades, indicating a positive signal for the company's outlook:

« Mr. Lu King Seng, an independent director, bought 100,000 shares.
* Mr. Philip Hendry, Chief Operating Officer, bought 580,000 shares.
« Mr. Adam Tan Sheng Hua, Chief Financial Officer, bought 80,000 shares.

On 5th October, Nordic announced its intention to acquire Avon Industries
Pte. Ltd., whose expertise lies in the engineering, design, construction, and
maintenance of airport fuel systems, serving both commercial and military
clients.

Below are the key details of this acquisition:

continued on next page...
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- The acquisition is valued at and Midkcon colR e

approximately SS5.0 million, to be

paid in cash.

-+ Avon's net tangible assets were
reported to be around S$5.1
million for the fiscal year ending in
September 2022.

- A condition for completion is that Avon must have a minimum cash
position of SS2 million.

Rationale for Acquisition:
- The acquisition aligns with Nordic's strategic plan to broaden its range of
services and customer base.

 Synergies are anticipated in the areas of operation and maintenance
services, which could extend to government agency contracts.

- Nordic expects to integrate its existing services with Avon’s offerings,
potentially enhancing its own product and service suite, as well as cross-
selling opportunities.

Expected Financial Impact:

- Had this acquisition been completed at the start of FY2022, the projected
earnings per share for Nordic would have increased to 5.4 cents from 5.3
cents.

From the information given so far, we think that it is a low-risk acquisition
due to a reasonable valuation and it gives the company to expand its
service offering for a better total addressable market.

Read Also: In Conversation with Nordic's Executive Chairman: Decoding a
Decade of Strategic Transformation and Growth

Hyphens Pharma has announced its plan to solidify its position in the

continued on next page...
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medical aesthetics market with Tracking a Live portfolio of local small

and mid-cap companies

the proposed acquisition of the

58% remaining stake in Ardence

Pharma. Here is a summary of the

announcement:

- As Hyphens Pharma already has
a 42% shareholding of Ardence
Pharma, the proposed acquisition
will make Ardence Pharma a wholly-owned subsidiary.

- Consideration is S$1.86 million for Tranche 1 of the Proposed Acquisition
representing 23% of the share capital of Ardence Pharma, with two
remaining tranches of 17% and 18% respectively.

« Proposed Acquisition is part of the growth strategy to expand nascent
medical aesthetics business and will enhance and enlarge the Group’s
revenue and profits while strengthening its presence in Malaysia.

The company continues its most aggressive buy-back streak since its IPO.
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In 2023, they have bought back 0.35% of their total share so far using
roughly SS$S1.4 million.

Insider trade: CEO Chua Leong Hai and substantial shareholder Chua Siok
Hong have spent SS$276,275 and S$50,000 respectively to acquire their
company share via market transactions.
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Investor-One Portfolio [0

of 553 billion and
below

Curated by Investor-One team, this portfolio features growing small and
mid cap companies within Singapore Exchange Catalist and Main Board. %

INVESTOR-ONE PORTFOLIO

The criteria for the companies are selected based on the following S

. . . . . . Net Debt/Equity Positive Free Cash
metrics, with further evaluation on qualitative factors like management (<2times Flow
team and growth prospects:
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Note: The Portfolio Return indicated in the chart does not include dividend income, as opposed to Total Return that is inclusive of Dividend Income.
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Summary [ 0s-11-2023 ) Open Positions

Unrealized PIL < -4,100

INVESTOR-ONE PORTFOLIO

P/L +
Name+4 Chg PL Div Cost Value

Geo Energy Res . : : -0.01 (-3.28%) -485 g 1,131 10,013 9,529
(-4.84%)

Hock Lian Seng i . . -800 5,800 5,000
{-13.79%)

HRnetGroup 23.14% ; . : -1,500 15400 13,900
(-9.74%)

Hyphens Pharma 3 ' ; -1,000
(-B.67%)

JEP Hidgs 17.47% ; . -0.01 (-2.99%) 485 (4.84%) 10,013

Kimly 5.08% : : -850 4,000
(-23.75%)

Nordic : . : 150 (3.80%)

Summary (08-11-2023 ) Closed Posilions

Realized Profit  « -2.500
Names P/L + Div Proceeds

HG Metal p F 50 3,400

InnoTek ; F y ¥ 4,800

Transaction (09-11-2023 )

Stock Exchange Rate Amount Datee

JEP Hldgs i NIA E 10,013 4 Jul 2023
HG Metal » MIA i 3,400 13 Mar 2023
InnoTek . MNIA ; 4,800 13 Mar 2023

Geo Energy Res k MIA i 10,013 13 Mar 2023

=

HRnetGroup ; N/ g 15,400 16 Feb 2022

@
=

E o o

¥ & E

. . . ! E ! o
3

Kimly ' NJA : 4,000 16 Feb 2022

HG Metal : . 3,750 16 Feb 2022

InnoTek x i 7,350 16 Feb 2022
MNordic i g 3,950 16 Feb 2022
Hyphens Pharma B A 15,000 16 Feb 2022

Hock Lian Seng : ; 5,800 16 Feb 2022

B

Deposit 100,000 15 Feb 2022
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Dividend (09-11-2023

YTD

TRAILING 12 MONTHS

2022

SGD 5276.70

SGD 5276.70

SGD 2459.20

Stock

Ex-Date

Payable Date

Amt

Amt(SGD)

HRnetGroup

30 Aug 2023

11 Sep 2023

SGD 0.0187

0.0187

Geo Energy Res

28 Aug 2023

06 Sep 2023

SGD 0.0050

0.0050

Nordic

17 Aug 2023

04 Sep 2023

SGD 0.0100

0.0100

Hyphens Pharma

16 Aug 2023

31 Aug 2023

SGD 0.0360

0.0360

Kimly

27 Jun 2023

14 Jul 2023

SGD 0.0056

0.0056

Geo Energy Res

29 May 2023

08 Jun 2023

SGD 0.0050

0.0050

Hyphens Pharma

09 May 2023

24 May 2023

SGD 0.0111

0.0111

Geo Energy Res

08 May 2023

17 May 2023

SGD 0.0400

0.0400

Nordic

07 May 2023

17 May 2023

SGD 0.0091

0.0091

Hock Lian Seng

07 May 2022

19 May 2022

SGD 0.0100

0.0100

HRnetGroup

03 May 2022

12 May 2022

SGD 0.0187

0.0187

Kimly

26 Jan 2022

08 Feb 2022

SGD 0.0112

0.0112

HRnetGroup

28 Aug 2022

06 Sep 2022

SGD 0.0213

0.0213

Nordic

16 Aug 2022

02 Sep 2022

SGD 0.0116

0.0116

Kimly

29 Jun 2022

15 Jul 2022

SGD 0.0056

0.0056

Hyphens Pharma

11 May 2022

25 May 2022

SGD 0.0067

0.0067

InnoTek

10 May 2022

25 May 2022

SGD 0.0200

0.0200

Hock Lian Seng

08 May 2022

20 May 2022

SGD 0.0125

0.0125

HRnetGroup

08 May 2022

18 May 2022

SGD 0.0300

0.0300

Nordic

05 May 2022

17 May 2022

SGD 0.0015

0.0015

Nordic

05 May 2022

17 May 2022

SGD 0.0061

0.0061

HG Metal

05 May 2022

20 May 2022

SGD 0.0400

0.0400

INVESTOR-ONE PORTFOLIO

This portfolio is managed by Investor-One research team, under Sharelnvestor.

Disclaimer:

1. The Investor-One portfolio is aggregated for educational and illustration purposes only. It is curated based on fixed financial parameters as
indicated above. The investor-one team select their stocks solely base on the these fixed parameters. The featured companies are for information
only and does not constitute investment advice.

. The investor-one team is not licensed by any financial authority in Singapore. You should consult your Trading Representative or Financial Advisors
before making any financial decisions.

. Current Price, current value and gain/loss (%) under current portfolio are based on 10 minutes delayed data.
. Purchase Price and Exit Price are based on EOD price.
. The views and opinions expressed does not necessarily reflect those of Sharelnvestor Pte Ltd nor any related companies of Sharelnvestor Pte Ltd.
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COMPANY SPOTLIGHT

Analyst Alert: Research Reports On
SGX Listed REITs & Stocks (2 Nov)

Investor-One / Thu, Nov 2, 8:00 PM
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Welcome to our weekly compilation, a curated collection of summaries and
insights from Singapore's leading research houses. We've gathered them
here for the convenience of Singapore's retail investors. This digest aims to
simplify the task of staying updated by consolidating the week's key market
perspectives in one place. We hope it serves as a useful resource for those
seeking to understand the broader market landscape.

1.UOB KayHian: Sheng Siong
2.UOB KayHian: Tiong Woon
3.CGS CIMB: iFAST

4.Phillip Capital: China Aviation Oil
5.Maybank Kim Eng: CSE Global
6.Maybank Kim Eng: Civmec Ltd

continued on next page...
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SGX: OV8

Recommendation: BUY

Share Price (2 November 2023): S$1.55
Target Price: S$1.97

Upside: +27.1%

Company Overview
Sheng Siong Group (SSG) is a mass-market supermarket operator in
Singapore. It is the third-largest player in Singapore by market.

Financial Performance

» Earnings: S$34.8m for 3Q23 (+5.7% yoy, +8.1% qoq), with the 9M23
PATMI being 72.9% of the full-year estimate.

« Revenue: Increased by 3.7% yoy due to the opening of six new stores.

« Margins: Gross profit margin at 30.3% (+0.9ppt yoy) and net profit margin
at 10.1% (+0.2ppt yoy).

 Expenses: Administrative expenses rose by S$6.0m (+10.2% yoy), largely
from staff and utility costs.

New Store Opening Outlook

 Singapore: 2 new stores in 9M23, totaling 69 stores. Total retail area:
618,349sf (+2.6% yoy).

« HDB's BTO Supply: Increase of 34.5% from 2021-2023, aiming for 100,000
flats by 2025. SSG has bid on three tenders, and five more locations up
for tender soon.

 China Operations: Contributed to 2.4% of 3Q23 revenue. A sixth store in
Kunming to open by 2Q24.

Sales Strategy Amid Inflation
* Forecasts:
» Core inflation at 2.5-3.0% by Dec 23;
« 2.5-3.5% for 2024;
 headline inflation around 5% for 2023, and 3-4% for 2024.
« Consumer Behavior: Shift towards value-for-money purchases due to
inflation. SSG to benefit as consumers reduce dining out.
+ SSG will focus on a sales mix of higher-margin products, expanding
house brand offerings, and enhancing supply chain efficiencies to counter
rising food prices and maintain margins.

continued on next page...
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Valuation & Catalysts

Valuation Basis: Target price derived from 21x 2024F EPS or the five-year
average mean PE.

Catalysts: Potential surge in demand due to new store openings, sales
growth, inflationary environment, and GST hikes.

Analyst: John Cheong / Heidi Mo

Read the full report here...

Read Also: DuPont Analysis of Sheng Siong

SGX: BOM

Recommendation: BUY

Share Price (1 November 2023): SS0.50
Target Price: S$0.85

Upside +70.0%

Company Background

Tiong Woon Corporation Holding and its subsidiaries provide heavy lift,
heavy haulage, transport services and engineering services. The company
also offers crane services and provides wharfing and stevedoring services.

Strong Position in Industry

- Owns over 500 cranes, some with a capacity of up to 2,200 tonnes.

- Stands to gain from the resurgence in Singapore’s construction activities,
significant public housing projects, and rising capital expenditure in the oil
& gas sector.

- The construction sector will benefit from major projects like the Cross
Island Line, Changi Airport T5, and Tuas Mega Port.

Positive Outlook

- A shift from being “cautiously optimistic” to highlighting “a positive outlook”
due to steady demand in sectors like petrochemicals and construction,
especially in key markets like India, Saudi Arabia, and Thailand.

- Secured contracts for Singapore’s Integrated Waste Management
Facility and two heavy-lifting projects in India, which are set to contribute
significantly to FY24 earnings.

continued on next page...
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Earnings Growth

- FY23 saw a 38% yoy growth, with FY24 projected to grow by 20% yoy.

 This growth is driven by increased utilization and crane rental rates,
catalyzed by heightened construction activities in Singapore.

Analyst: John Cheong

Read the full report here...

SGX: AlY

Recommendation: HOLD

Share Price (October 27, 2023): S$6.13
Target Price: S$5.90

Upside: -3.8%

Company Description
iFAST is an Internet-based investment products distribution platform.

Beating Consensus Estimates

- iFAST's 3Q23 Profit After Tax and Minority Interests (PATMI) was SS8.5m,
which is a significant increase both quarter-on-quarter (qoq) and year-on-
year (yoy).

 This performance was aligned with CGS-CIMB's expectations and
surpassed Bloomberg's consensus by 12%.

- The difference from the consensus was mainly due to the ePension
project's more substantial and earlier-than-expected contributions.

Ramp-up of ePension

- The ePension project's operational phase has begun, with a seven-year
timeframe for project fees.

- The estimated contribution from ePension was around SS$4.8m Profit
Before Tax (PBT) in 3Q23.

« The overall earnings from Hong Kong are predicted to align with the
guidance of approximately SS17m PBT for FY23.

Steady Underlying Business Growth
* iFAST's core platform business maintained its momentum in 3Q23,
predominantly led by Singapore.

continued on next page...
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- AUA saw moderate growth, reaching S$19.1bn in 3Q23.

- There was a notable net inflow of S§751m, the highest since 4Q21.

- iFAST Global Bank's customer deposits also witnessed an encouraging
rise, while the banking division recorded losses of S$2.1m in 3Q23.

Future Projections and Considerations

* CGS-CIMB raised their EPS estimates for FY23-25F by approximately 23-
39%, primarily due to contributions from Hong Kong.

« The research house reiterated a HOLD recommendation with an
increased Target Price of S$5.90.

- iFAST plans to contemplate a dividend policy with a payout ratio of
around 30-50% in FY24F.

- Potential risks include stronger trading volumes on the upside and project
implementation delays on the downside.

Analyst: Andrea Choong

Read the full report here...

SGX: G92

Recommendation:

Share Price (30 October 2023): SS0.765
Target Price: S$1.01

Upside: 34.2%

Company Description

China Aviation Qil (Singapore) Corporation Ltd (CAO) is a key player in
supplying imported jet fuel to the civil aviation industry in China. 51.3%
owned by the state-owned China National Aviation Fuel Group Limited, CAO
is also involved in marketing jet fuel internationally, international trading

of various oil products, and carbon credits. A significant stake in Shanghai
Pudong International Airport further strengthens its position, which
accounted for 62% of its net profit in FY22.

Key Highlights

- International passenger traffic in China has surged with the rebound in air
travel demand, particularly after borders re-opened in early 2023.

+ China's jet fuel consumption has grown significantly, with a compounded

continued on next page...
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annual growth rate (CAGR) of 8.4% over the last 10 years, indicative of the
rise in air travel demand. This has resulted in the addition of more airports
to cater to this demand.

+ China Aviation Qil (CAO) holds the potential to expand its reach to other
international airports in China, beyond the current five key ones.

- Three major Chinese carriers are planning a significant expansion of their
fleet in the coming years, reflecting optimism in the sector.

« CAOQO's earnings are expected to double over the next two years, and
around 64% of the market cap is in net cash of USS308mn (as at the end
of 2022).

Research Manager: Peggy Mak

Read the full report here...

SGX: P9D

Recommendation: BUY

Share Price (31 October 2023): SS0.76
Target Price: S$1.05

Upside: 38%

Company Description
Civmec is a construction and engineering services provider to the
Resources, Energy, Infrastructure, Marine & Defence sectors

Financial Highlights

* 1Q24 Net Profit: AUD15.2m, marking an increase of 7.3% YoY. This aligns
with both Maybank and general market expectations.

 Order Book: Stands strong with over AUD1.1b as of end-September 2023,
suggesting potential revenue.

« Net Cash Position: AUD43.9m, highlighting robust operating cash flows
and a healthy financial state.

* Revenue Insight: 1Q revenue was AUD245.1m, up by 7.3% YoY. Stable
net margins at 6.2% indicate operational efficiency despite increased
operating expenses.

« FY23 EBITDA Margin: Improved to 13.1% from previous years due to
better workforce utilization and reduced interest expenses.

continued on next page...
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Strategic Moves & Initiatives

- Redomiciliation to Australia: Civmec aims to redomicile from Singapore
to Australia. This move is likely to increase the company's chances of
securing more government and private contracts in Australia due to local
content preferences.

- New Maintenance Facilities: Plans are on track for the new maintenance
facility in Port Hedland. Another maintenance facility is proposed in
Gladstone, Central Queensland to establish a permanent operational
base.

Market & Clientele

 Sectors: Civmec provides integrated services to the Oil & Gas, metals &
minerals, infrastructure, marine, and defence sectors in Australia.

« Major Clients: Civmec's notable clientele includes industry giants such
as Chevron, Rio Tinto, Alcoa Australia, BHP, Thyssenkrupp, and the Royal
Australian Navy, indicating its credibility and capacity to handle major
projects.

Valuation & Growth

 Valuation: Civmec trades at a valuation considered to be undemanding
when compared to its industry peers.

« Growth Forecast: Expected Revenue CAGR of ~10% over the next 3 years,
supported by its steady order book.

Potential Factors & Risks

 Upside Factors: The potential for stronger-than-expected order wins,
improved margins through continued cost control, and the possibility of
higher dividend payouts due to enhanced earnings.

- Downside Risks: Concerns include the possibility of slower contract
acquisitions, unexpected margin pressures from increased raw material
and labor costs, and potential project execution mishaps leading to
delays or terminations.

Analyst: Eric Ong

Read the full report here...
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SGX: 544

Recommendation: BUY

Share Price (31 October 2023): SS0.40
Target Price: S$0.65

Upside: 70%

Company Description
CSE Global provides integrated systems solutions globally across the
Energy, Infrastructure, and Mining & Minerals sectors.

Main Points

« CSE Global's Prospects: CSE secured two major contracts, valued at
USD110.2m, for the design and manufacturing of power distribution
centres. These contracts are set to be executed between 2024-2025.

This has resulted in a strong order book for the company, which stood
at SGD521.8m as of 30 June 2023. Additionally, the year-to-date order
accumulation is about SGD675.7m.

« U.S. Market Opportunities: US President Joe Biden approved USD1.3bn
for building three interstate power lines. Given the US's push toward
electrification and the need to double grid capacity, CSE, with its expertise
in electrification solutions, is poised to benefit. Their contribution from the
US market is expected to surge by 100-200% over the next 2-3 years.

 Stock Potential: The recent dip in CSE's share price presents an
investment opportunity. The company is viewed as a top pick in the
SMIDs space, primarily due to its strong order book and growth potential
in electrification.

Value Proposition

« CSE stands out as a global system integrator and is positioned for a
multi-year upswing, benefiting from electrification and O&G trends.

- It has strong growth projections in energy, public infrastructure, and data-
centre segments.

- The company offers an attractive prospective dividend yield of over 6%
and trades at a discount relative to its peers.

Price Drivers
« The share price saw considerable growth when net profit for FY18 surged
by 50.8% YoY. However, it was hit by the global pandemic, leading to

continued on next page...
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a drop in equities. A rebound occurred due to robust orders, but some
projects’ cost overruns caused a profit decline. The company also did a
rights issue at SGDO0.33 per share.

Financial Metrics

- Maintenance revenue is projected to increase as more projects are
completed.

- The company's gearing is expected to decrease with the improvement in
its financial performance and operating cash flow. Part of this cash flow
will be utilized to reduce debt.

- Dividends are expected to remain at SGD0.0275/share, a rate maintained
historically.

« There's potential for conserving cash for Mergers and acquisitions if
lucrative targets emerge.

Swing Factors

 Upside: Factors contributing to a potential upside include strong NPAT
growth, a significant discount compared to peers, attractive dividend
yield, potential M&As, US O&G upcycle, and growth potential in US data
centers.

- Downside: Risks include potential execution errors leading to cost
overruns, global recessions causing business slowdown, and FX
fluctuations impacting profitability since CSE operates globally.

Analyst: Jarick Seet

Read the full report here...
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TOP SIGNIFICANT

INSIDER ACTIVITY

Direct Deemed Total Direct Deemed Total % Held ©
08 Nov 2023 LY Corp TAN KWEE LIM [SSH] S/U 345 345 0.040 2,303 355,160 357,463 73.120
(08 Nov 2023)
08 Nov 2023 LY Corp TAN KWEE CHAI [Dir/CEO] S/U 460 460 0.040 3470 355,160 358,630 73.360
(08 Nov 2023)
06 Nov 2023 Vertex SPAC UBS Group AG [SSH] S/U -655 -555 0.074 3,577 3,577 8.600
(08 Nov 2023)
06 Nov 2023 Vertex SPAC UBS AG [SSH] S/U -555 -555 0.074 777 2,800 3,577 8.600
(08 Nov 2023)
07 Nov 2023 ComfortDelGro Silchester International Investors LLP [SSH] S/U 1,524 1,524 1.340 108,840 108,840 5.026
(08 Nov 2023)
08 Nov 2023 Wilmar Intl Kuok Khoon Hong [Dir/CEQ] S/U 1,579 1,579 3.590 2,995 839,083 842,078 13.490
(08 Nov 2023)
071 Nov 2023 Mapletree Log Tr Temasek Holdings (Private) Limited ("Temasek") [SSH] S/U -500 -500 1.480 1,636,740 1,636,740 32.990
(08 Nov 2023)
08 Nov 2023 Mapletree PanAsia MPACT Management Ltd. [Tm/Rp] S/U 3,467 3,467 1.449 1.330 126,095 126,095 2.400
(08 Nov 2023) Com Tr
07 Nov 2023 Keppel Reit Keppel Land Limited ("KLL") [SSH] S/U -352,448 -352,448 0.820 1,123,768 1,123,768 29.709
(08 Nov 2023)
07 Nov 2023 CapLand Ascott T Deborah Lee Siew Yin [Dir/CEQ] D,OTH 250 250 0.915
(08 Nov 2023)
07 Nov 2023 Keppel Reit Keppel Land (Singapore) Pte. Ltd. ("KLS") [SSH] S/U -352,448 -352,448 0.820 1,123,768 1,123,768 29.709
(08 Nov 2023)
07 Nov 2023 Keppel Reit Keppel REIT Investment Pte. Ltd. ("KRI") [SSH] S/U 12 -352,448 0.820 1,123,768 1,123,768 29.703
(08 Nov 2023)
07 Nov 2023 Keppel Reit Keppel Corporation Limited ("KCL') [SSH] S/U -350,730 -350,730 0.820 0 1,408,628 1,408,628 37.240
(08 Nov 2023)
06 Nov 2023 Pegasus SPAC The Bank of New York Mellon [SSH] S/U -1,691 -1,691 4.800 315 315 1.030
(08 Nov 2023)
06 Nov 2023 Pegasus SPAC The Bank of New York Mellon Corporation [SSH] S/U -1,591 -1,591 4.800 315 315 1.030
(08 Nov 2023)
07 Nov 2023 SHS Robert Alexander Stone [SSH] S/U 700 700 0.120 29,200 19,700 48,900 8.011
(08 Nov 2023)
07 Nov 2023 SHS NG HAN KOK [Dir/CEQ] S/U -3,530 -3,530 0.120 23,038 92,647 115,685 18.950
(08 Nov 2023)
03 Nov 2023 IHH EMPLOYEES PROVIDENT FUND BOARD [SSH] S/U -1,589 -1,689 1.710 945,636 945,636 10.737
(08 Nov 2023)
07 Nov 2023 Keppel Reit Fong Mun Ngin, Mervyn [Dir/CEQ] S/U 0.44 1 2 0.820 56 3 59 0.002
(08 Nov 2023)
07 Nov 2023 Keppel Reit Tan Mei Ling, Carol Anne [Dir/CEO] S/U 2 2 0.820 2 2 0.000
(08 Nov 2023)
01 Nov 2023 Prime US ReitUSD Temasek Holdings (Private) Limited ("Temasek") [SSH] S/U -1,089 -1,089 0.091 105,953 105,953 8.900
(08 Nov 2023)
07 Nov 2023 Keppel Reit Tan Hua Mui Christina [Dir/CEQ] S/U 244 244 0.820 256 256 0.007
(08 Nov 2023)
07 Nov 2023 Keppel Reit Tan Swee Yiow [Dir/CEQ] S/U 114 114 0.820 1,968 1,968 0.052
(08 Nov 2023)
08 Nov 2023 Wing Tai Cheng Wai Keung [Dir/CEQ] S/U 40 40 1.330 214 466,898 467,113 61.340
(08 Nov 2023)
06 Nov 2023 SGX Tsien Samuel Nag [Dir/CEO] S/U 2 2 9.700 2 2 0.000
(07 Nov 2023)
06 Nov 2023 SGX Yeoh Oon Jin [Dir/CEQ] S/U 2 2 9.700 4 4 0.000
(07 Nov 2023)
06 Nov 2023 SGX Subra Suresh [Dir/CEQ] S/U 2 2 9.700 M 11 0.001
(07 Nov 2023)
06 Nov 2023 SGX Mark Stephen Makepeace [Dir/CEOQ] S/U 2 2 9.700 6 6 0.001
(07 Nov 2023)
06 Nov 2023 SGX Lim Chin Hu [Dir/CEQ] S/U 2 2 9.700 48 48 0.004
(07 Nov 2023)
06 Nov 2023 SGX Koh Boon Hwee [Dir/CEQ] S/U 25 25 9.700 25 25 0.002

(07 Nov 2023)

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
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resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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A FALL IN BOND YIELDS PROVIDES
RELIEF FOR STOCKS

-« As expected, the US Federal Reserve kept interest rates unchanged

 Despite Fed's message of “higher for longer”, US Treasury bond yields
fell, the 10-year yield down from 4.9% to 4.557%

- Benign US jobs report suggests Fed may hold rates unchanged at next
FOMC

 Probability of no rate hike at 13 Dec FOMC is at 95%

- Wall St stocks rallied, taking the STI up 82 points or 2.7% to 3,143.66

- MAS imposed curbs on DBS after spate of digital service breakdowns

- Singapore’s factory output grew in Oct but electronics decline continued

The week’s pivotal event took place on Wednesday with the latest US
Federal Open Markets Committee (FOMC) meeting.

As with most past meetings, there were no real surprises — the Fed left
interest rates unchanged, marking the second meeting in a row where the
central bank has skipped a hike in its current policy-tightening cycle.

The outcome, which was unanimous and had been widely expected, keeps
the target for the federal-funds rate at 5.25-5.50%.

Thanks to a rally in US stocks and bonds, the Straits Times Index added
82 points or 2.7% at 3,143.66. Volume however, was low , averaging just
S$928m per day.

Most of the gains came on Friday, when the STl jumped 61 points or about
2%. The bulk of this came from the banks led by UOB, which had dropped
SS0.21 on Thursday, but bounced SS0.78 pr almost 3% to S$27.71 on
volume of 3.3m on Friday.

continued on next page...
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However, the FOMC's statement said the “Committee is strongly committed
to returning inflation to its 2 percent objective”, whilst at a press conference,
Chair Jerome Powell said that officials weren't yet satisfied with the
progress being made on inflation and that monetary policy might not be
restrictive enough.

He also said policy makers are also watching rising bond yields, which have
also contributed to tighter financial conditions.

“Inflation has moderated since the middle of last year and readings over
the summer were quite favourable. But a few months of good data are only
the beginning of what it will take to build confidence that inflation is moving
down sustainably toward our goal,” Powell said.

US stocks rose after the FOMC meeting, mainly because bond yields
backed down from their recent highs. On Wednesday, the 10-year Treasury,
which last month crossed 5% for the first time since 2007, closed at
4.733%.

Stocks had their best week of the year after Friday’s jobs report came in
cooler than expected, sending the 10-year Treasury yield lower.

The U.S. economy created 150,000 jobs in October, the Labor Department
reported on Friday, marking a larger-than-expected slowdown from
September amid auto strikes and moderation in the leisure and hospitality
sector.

The report should give the Federal Reserve more flexibility to hold interest
rates steady next month.

The 10-year Treasury yield fell 0.289 percentage point to 4.557% this
week after soaring north of 5% last month. The 30-year yield fell to 4.75%,
marking its largest one-week decline since March 6, 2020.

continued on next page...
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The Monetary Authority of Singapore (MAS) on Wednesday said it has
imposed a “six month pause” on DBS, during which the bank will have to
suspend non-essential changes to its IT systems and will not be allowed to
take on new business ventures.

During this period, only IT system changes related to security, regulatory
compliance and risk management will be allowed, said MAS.

“This is to ensure that the bank dedicates the needed resources and attention
to strengthen its technology risk management systems and controls,” it

said. DBS will also not be allowed to reduce the number of its branches and
automated teller machines (ATMs).

The DBS Board and Management today apologised for the series of digital
disruptions this year, and said the bank is addressing the issues at hand
with utmost priority. Apart from breakdowns on 14 and 20 Oct, there were
also disruptions on 29 March, 5 May and 26 Sep.

On Thursday when the STl rose 5.72 points to 3,082.49, DBS's shares sank
SS0.37 or 1.12% to S$32.66 on volume of 3.3m. However, they rebounded
SS0.63 or 1.93% on Friday to S$33.29 with 3.6m traded.

Singapore’s purchasing managers’ index (PMI) edged up to 50.2 in October,
a 0.1 point gain from the previous month. A reading above 50 on the index
indicates growth from the previous month, while one below 50 points to a
contraction.

However, the electronics sector contracted for the 15th consecutive month
in October, though at a slower rate than the month before. The sector
gained 0.1 point to 49.9 in October.

Private-sector economists cautioned that the manufacturing sector’s
recovery is still uncertain, given that the electronics sector’s turnaround has
yet to stabilise.

continued on next page...
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The Business Times quoted UOB associate economist Jester Koh “While
we are heartened by the broad-based improvement in October’s overall PMI,
we caution that the manufacturing sector could remain downbeat in the
near term - likely for the rest of 2023 and into early 2024 — given the weak
external demand”.

“The sub-50 reading for electronics PMI reaffirms the assessment that the
electronics sector is likely to remain lacklustre in the near term.”

The improving trend of Singapore’s overall manufacturing PMI over the past
few months is a “nascent sign” that a gradual yet fragile manufacturing
recovery is possibly underway, BT quoted DBS economist Chua Han Teng as
saying.

But the continued electronics PMI contraction signals that the electronics
turnaround is not yet firm, added Chua. “The global economic backdrop

is still uncertain amid high interest rates in advanced economies, bumpy
conditions in China and lingering geopolitical tensions that could disrupt
supply chains.”

SingPost reported a net profit of S$11.5m for the fiscal first half ended Sep
30, from a net loss of $S$9.9 million a year before. The better performance
was despite a 13.7% year-on-year fall in H1 revenue to S$827.3m. The
revenue decline was mainly due to the “normalising of sea freight rates
and volumes post pandemic, as well as foreign exchange impact”. The

net profit was driven by lower volume-related expenses and operating
expenses, as well as a smaller loss on exceptional items.

Great Eastern reported a 21% increase in net profit to S$180.2m for its third
quarter ended 30 Sep on the back of a 5% increase in total weighted new
sales of S$419.4m. For the nine months to 30 Sep, net profit rose 65% to
SS$617.4m led by higher profit in the Singapore Life business and favourable
investment performance in the shareholders’ fund.

First REIT posted a 6.1% fall in distribution per unit (DPU) for the third
quarter ended 30 Sep to S$0.0062. DPU for the nine months was SS0.0186,
down 6.1% versus the same period last year. Rental and other income for

continued on next page...
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the 9-month period rose 0.6% to SS81.4m but net property income stayed
flat at S$79.1m. Distributable income for the nine months was 1.2% lower
at SS38.4m. The 3Q distribution will be paid on 22 Dec, after books closure
on 9 Nov.

Parkway Life REIT reported a 2.8% increase in DPU for the nine months
ended 30 Sep to SS0.1099. This is including a 3Q DPU of S$0.037 which
will form part of the second half distribution when the REIT announces its
full-year results. Net property income for the nine months was S$104.5m,
26.2% higher than last year, while gross revenue rose 24.6% to S$110.9m.
These increases were attributed to contributions from five nursing homes
acquired in Sep 2022, as well as higher rent from Singapore properties
under new master lease agreements.

SIA Engineering Company reported an 82.6% increase in profit to $$59.3
million for the six months ended Sep 30, 2023. Revenue rose 41.9% to
nearly S$514 million in H1, on the back of a rebound in the travel sector,
with flight activities growing post-pandemic. This brings earnings per share
to $S0.0528 up from SS0.0289 the previous year.

For more information on membership and events, contact SIAS via www.sias.org.sg

SHAREINVESTOR

C2 Chart is WebPro's new feature-packed technical analysis tool for the
modern stock investor

Select your preferred indicators to best

: - : Extract price data from over 30 years
suit your technical strategies

Multiple drawing tools to easily identify

chart patterns Various charts to suit your preferred style

Key events can be pinned onto your

» - Access your charts from any computer or mobile
charts for a better overview

Conveniently compare multiple stock

prices at the same time Intuitive zooming function on charts
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IiP jun yuan Jun Yuan's insights, strategies, and

advice have helped many on their
investing journey. The road to
retirement can be challenging, but it

Definitely a must-read for investors looking to build a passive income flow!

Especially in a Singapore context, REITs is one of the many way to build up your recurring
income as a means for retirement. in his book. Jun Yuan gives a very thorough views on

REITs. From the basic concepts and understandings of REITs, to the valuing / monitoring /
investing aspects of REITs, Jun Yuan has not only provide the simple ABCs (what), but also
the application (how) to provide some action-able considerations.

Personally, | also like the “"bonus chapters” that help to address some FAQs, and provide
an overview of the various REITs that are listed on SGX.

Highly recommended to those who want to kick-start his or her journey in bullding up a

doesnt have to be. This book is your
roadmap to financial security in
retirement. Learn how to build a robust
REIT portfolio that will provide you with

REIT-irement portfolio.

a cushion during your retirement years,
so you can finally bid farewell to
financial worries.

- Dan Chang C S, Trading Representative. PhillipCapital

I am specially honoured to help Jun Yuan with this review as he is definitely more savwwy in
REITs investing than me.

At first glance. the book provides a comprehensive and well-structured framework to share
on various aspects of REIT investing, guiding readers throughout the whole process of
buying and monitoring REITS,

Upon further reading. 1 am amazed of the value offered in this book such as the S-point
criteria checklist. practical case studies and 4 potential red flags we should take note of,

$29.00

Delivered via registered mail

- James Yeo, Founder @ InvestKaki.com

Terms and Conditions

«For registered mail purchase, the buyer must ensure their mailing address is correct
Sharelnvestor will not be liable for any book that is mailed to the wrong address or the loss
of any books in the mail

=By purchasing the book, the buyer agrees to the Terms & Conditions stated.
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e NMERIAL Operational Performance For 3Q 2023.

_—

Z-.. FRASERS

Reports Strong Financial &

NPI in 3Q 2023 increased 29.8% YoY to S$62.7 million driven by overall portfolio
improvement. Committed occupancy of Singapore office portfolio remained healthy
at 95.7% as at 30 September 2023 with positive rental reversion of 18.4% in 3Q 2023.
3Q 2023 hospitality segment RevPAR increased 12.8% YoY to S$295. Crowne Plaza
Changi Airport asset enhancement on track to complete by December 2023 to capture
visitor rebound in 2024. Obtained investment grade credit rating of BBB- with a stable
outlook from S&P Global Ratings, interest rate of 4.20% notes due 2027 will step down

to 3.95% resulting in some cost savings.
http://ouect.listedcompany.com/news.html/id/2463894

Jointly Establish CapitaLand Wellness
Fund With Pruksa Holding To Invest In Wellness & Healthcare-
Related Real Estate In Southeast Asia.

CapitaLand Investment Limited and Pruksa Holding Public Company Limited are pleased to
announce the establishment and the first close of the inaugural wellness and healthcare-related
real estate fund, CapitaLand Wellness Fund. CLI and PSH have jointly committed an initial equity
investment of S$350 million towards the fund’s target equity size of SS500 million, with an option
to upsize to SS1 billion in equity and target asset value of S$2.9 billion when fully deployed.

http://cli.listedcompany.com/news.html/id/2464092

Cap/taLand

Reports 82.9% Growth In New Orders To S$301.6

cse global Million In 3Q2023.

CSE Global Limited secured S$301.6 million of new orders in the third quarter ended 30
September 2023, mainly driven by stronger electrification and communications solutions in
the Infrastructure sector, compared to S$164.9 million of new orders in 3Q2022. In 3Q2023,
new orders for the Electrification’s business segment surged by 122.0% to S$188.0 million
as compared to S$84.7 million in 3Q2022. This was mainly due to the major electrification
projects secured that were announced on 1 August 2023 and 17 August 2023, which
included the design and manufacturing of power distribution centres and integration of
electrical and control systems and equipment in the United States of America.

http://cseglobal.listedcompany.com/news.html/id/2464098

To Focus On Laboratory Construction And Co-
Working Laboratory Space Business.

The Board of Directors of waste-to-energy subsidiary Neo Tiew Power initiates process to
place the company under Creditor’s Voluntary Liquidation. Group views action as prudent
for optimal allocation of resources. The Group will continue to focus on its encouraging
cash flow positive laboratory construction and co-working laboratory space businesses.

http://acrometa.listedcompany.com/news.html/id/2464198

TRUST

ACRO.

GROUP

Reports FY2023 DPU Of 7.04 Singapore Cents.

""F,” LOGISTICS & COMMERCIAL Healthy average portfolio rental reversions of +7.8% (incoming rent vs. outgoing rent
basis) and +18.9% (average rent vs. average rent basis) achieved for FY2023. Maintained

a high portfolio occupancy rate of 96.0% with full occupancies for the logistics &
industrial portfolio. Acquisition of a freehold forward-funding logistics development in
the Netherlands at a 12.7% discount to valuation. Healthy aggregate leverage of 30.2%
as at 30 September 2023, with high interest coverage ratio of 7.1 times. No major
refinancing is due in THFY24. Over 98% of debt maturing in FY2024 is due in 2HFY24.
Facilities are already in place for more than half of the debt maturing in FY2024.

http://flt.listedcompany.com/news.html/id/2464412

ANNOUNCEMENTS


http://flt.listedcompany.com/news.html/id/2464412
http://ouect.listedcompany.com/news.html/id/2463894
http://cli.listedcompany.com/news.html/id/2464092
http://acrometa.listedcompany.com/news.html/id/2464198
http://cseglobal.listedcompany.com/news.html/id/2464098
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